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Online presentations are a success! 
Hopefully by now, you have watched the new online presentations launched March 
27 on the public school employees website. If you have, you aren’t alone —the 
presentations seem to be (pardon the pun) a big hit. In a 20-day period, the page 
that the presentations are launched from had 1,043 hits!  

A more accurate measurement comes from 
the quiz results. The number of people who 
have taken the post-presentation quiz 
indicate the viewer has watched the 
presentation and retained most of the 
information presented. A total of 363 people 
completed the quiz after watching How to 
Earn & Buy Service Credit and 121 
completed the How to Pay for Service 
Credit quiz. 

Results from the How to Earn & Buy 
Service Credit quiz showed that after 
viewing, 89.4 percent said they felt confident about their decision to purchase or not 
purchase service credit. Another 96.5 percent said that they felt confident in making 
a decision on how to pay for their service credit purchase after viewing How to Pay 
for Service Credit. 

The presentations were announced to public school payroll offices in an April email 
from Pam Kenney. They have also been mentioned at Preretirement Information 
Meetings. The Customer Education and Development (CED) team plans to do more 
advertising of the presentations in September.  

CED is exploring a number of topic ideas for future vignettes. Keep reading the 
LookOut for updates.  

Roles and Responsibilities Reviewed 
When ORS was aligned as a process-based organization, each process was 
assigned a BPO and BPL. The BPOs and BPLs, in addition to the Executive 
Process Owners (Phil, Laurie, Kathy, Anthony, and Tim), and the Process 
Champions (Chris and Phil), all had clearly defined roles. These roles emerged 
mostly from literature on process orientation written by Michael Hammer, and we 
had detailed them in a Roles and Responsibilities document. 
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AST Application Support 
Team 

BLA Business 
Leadership 
Assembly (Consists 
of the EPC, BPOs, 
and BPLs) 

BPD Benefit Plan Design 

BPL Business Process 
Leader 

BPO Business Process 
Owner 

CED Customer Education 
and Development 

CSC Customer Service 
Center 
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Information 
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Management and 
Budget 

EPC Executive Process 
Council (Chris, 
Laurie, Phil, and 
Tim) 

EPO Executive Process 
Owner 

ER Employer Reporting 

In recent years, as the BPOs became more involved in the Vision ORS project, 
many of their roles were shifted to the BPLs or other process staff. Because the end 
of the project is approaching, BPOs, BPLs, and EPC recently dusted off this 
document to review and refine roles and responsibilities. Their goal was to realign 
leadership roles to be more in line with what a process organization should look like.  

This review turned out to be great timing – with the ORS realignment that occurred 
in March, we now have one BPO in the business for each process, which better 
reflects a true process orientation. In addition there are new people filling these 
roles. Kerrie Vanden Bosch said, “As a new BPO, the new “Roles and 
Responsibilities” document has been tremendously helpful for me in making sure 
that I am fulfilling my new role appropriately and that I am not missing things.” 

If you have any questions about the process or about what the roles and 
responsibilities of BPOs, BPLs, EPOs, and the Process Champions are, please 
contact your BPO or BPL.   

Update your info 
With the recent staff moves, have you verified that your information in the Phone 
Resource database is still accurate? This database is an excellent tool for all of us to 
access the most up-to-date information about who handles what, where an individual 
sits, and what his or her phone number is. But it only works when each of us does 
our part to update our information. 

Please take a few minutes right now to check and update your record. The database 
can be found at F:\Process Support\Phones\Phone_ResourceTool. 

Did you know …  
… that a cricket chirps to the temperature? It’s true! To convert cricket chirps to 
degrees Fahrenheit, count the number of chirps in 14 seconds then add 40 to get 
the current temperature. 

For example: If a cricket has 30 chirps in 14 seconds, you add 40, and your final 
temperature calculation is 70° F. 

To convert cricket chirps to degrees Celsius, count number of chirps in 25 seconds, 
divide by 3, and then add 4 to get the temperature. 

For example: A cricket has 48 chirps in 25 seconds. You divide that by 3 and add 4; 
the temperature would be 20° C. 

The information in this article was found on the website for The Old Farmers 
Almanac. For more information, visit www.almanac.com.  

Reengineering results 
As you know, one of ORS’s main goals for the year is to reengineer select 
processes. The Vision ORS project has provided us with new technology; now we 
need to make sure we are using this technology in the most efficient way and to its 
fullest extent. In the month of April, six tasks in the insurance area were 
reengineered: Insurance Changes, COBRA, Pays-Us, Long-Term Care Insurance, 
Hearing Aids, and the flow of insurance-related information into ORS and throughout 
the organization. 

Many subject matter experts (SMEs) dedicated their time to mapping the process 
currently in place, identifying gaps or areas of improvement within the process, and 
then designing a new, more efficient process that closes these gaps. Although the 
reengineering team facilitated the process, the ideas for improvement came from the 
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ORS Office of Retirement 
Services 

PS Process Support 

T&T Tools and 
Technology 

News You Can Use 

Tracker tool. PS 
announces a new 
tool, click here for 
more information on 
the upgrade to Clarety 
File Tracker. 

Office Map. If you're 
wondering where staff 
have moved, check 
out the latest office 
map to get their new 
location.  

Accounts Payable 
staff makes a move 
Effective June 19, 
DMB Financial 
Services Accounts 
Payable, Procurement 
and Security/Post 
Audit Units (currently 
located in the Mason 
Building) will be 
moving to the Lewis 
Cass Building. Their 
ID mail address will 
change to: 

DMB 
Financial Services  

Operations 
Lewis Cass Bldg. 

2nd Floor 

You will need to use 
the new address for 
submitting travel 
vouchers, accounts 
payables, and p-card 
transactions. Their 
phone numbers will 
not be changing. 

SMEs. The efficiencies we will gain were because of their great ideas and hard 
work. 
Throughout the reengineering process, the team has kept track of the quantitative 
efficiencies gained (i.e., those that can be tracked numerically such as handoffs 
eliminated, cycle time reduced, staff time savings) as well as qualitative savings 
(those that can’t be tracked numerically but lead to higher quality and better 
customer service).  

The table below displays the quantitative savings per year that we have been able to 
achieve in each of the reengineered insurance tasks: 

 
In addition to these quantitative savings, we identified 20 areas of qualitative 
measures where we could improve quality and/or customer service. 

It’s important to point out that while we are tracking full time equivalent (FTE) 
savings, ORS will not be reducing staff as a result of the reengineering project. 
Rather, it is expected that ORS will continue to take on more work as our retiree 
population grows.  
In the next several weeks, CSC and BPD leadership will develop implementation 
plans for each of these newly designed tasks, and then work with staff to implement 
the changes. 

Battalion receives gifts with delight 
Maureen Carden received word from the battalion leader that our care packages 
arrived in Kosovo and were very warmly received. He asked Maureen to thank all of 
you from all of the troop members. 

Also, we got word from our special adopted soldier Joe Drysdale who said, 
"Everyone here always appreciates what we get from the states, but your packages 
were special because they contained items that we really wanted, not necessarily 
what we need!” 
Please remember that we are still collecting items until the end of each quarter, for 
the entire year. 

The list of suggested items is: 

 Phone cards - $10 international phone cards are the best deal; all phone cards 
are accepted.  

 Magazines - Sports Illustrated, ESPN, hunting and fishing magazines, etc. 
Local newspapers.  

 Music and Movies - Any CDs or DVDs.  

 Snacks - Especially cookies, Pringles, Slims Jims, Pop Tarts, candy, all types 
and gum.  

 Monetary donations - help assist with postage/mailing expenses.  

Task Name Handoffs 
Eliminated 

New Tasks Phone 
Staff Can Complete 

Days Saved in 
Cycle Time 

Cost 
Savings 

FTE 
Savings 

Insurance 
Changes 3 0 5 $632.84 2.4207

Hearing Aids 6 0 5 $11.72 .0057

Long Term Care Qualitative 
savings only     

COBRA 5 1 18 $37.49 .1046

Pays-Us 4 0 0 0 .768

Information Flow 0 0 30 0 .055

TOTAL 18 1 58 $682.05 3.354
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Please drop off your donations and address questions to Maureen Carden, Cubicle 
G1. You may also contact Linda Turner, Cubicle D3, if you have questions. 
Thank you again for your generosity and support. Remember, anything you can do 
will make a difference in the life of a soldier!  

Dad’s day to shine 
Contrary to popular belief, Father’s Day was not the invention of the greeting card 
industry (even though it’s the fourth most popular card-sending holiday, with an 
estimated $100 million in card sales). 

Sonora Louise Smart Dodd, of Spokane, Washington, proposed the first Father's 
Day idea in 1909 to honor her father, who single-handedly raised Dodd and her five 
siblings after his wife died giving birth to their sixth child. It has been celebrated 
annually since then; in 1972 President Richard Nixon signed the public law that 
made it permanent. 

What is a father? 
Fatherhood is pretending the present you love 
most is soap-on-a-rope. - - Bill Cosby 

If mom says "no," she means it. If dad says 
"no," it means maybe. - - Joseph, age 13 

When your mom is mad at your dad, don't let 
her brush your hair. - - Morgan, age 11 

My dad will never be color coordinated.  
- - Samuel, age 11 

One evening a little girl and her parents were 
sitting around the table eating supper. The little 
girl said, "Daddy, you're the boss, aren't you?" 
Her Daddy smiled, pleased, and said yes. The 
little girl continued "That's because Mummy put 
you in charge, right?" 
  

Mackinac Island Lilac Festival 
If you’re looking for something to do the 
next couple of weekends, consider 
checking out the Mackinac Island Lilac 
Festival. The annual festival, now in its 
57th year, begins today, June 9, and runs 
through Sunday, June 18. The lilacs on 
the island are known for their large size 
and great age. The majority of them are 
the common purple, but white lilacs can 
also be seen. Events include teaching 
sessions by the International Lilac 
Society, a dog and pony show, free 
concerts, and the Lilac Festival Grand 
Parade.   
  

A blast from the past 
Lookout articles from this week in 1998: 

 
For more information check out: 
www.MackinacIslandLilacFestival.com 

Page 4 of 8ORS LookOut

7/27/2015file://\\hct084vsnapf001\dmb2\Retire\Shared\Common\Customer Education\Lookout\2006...



  

Page 5 of 8ORS LookOut

7/27/2015file://\\hct084vsnapf001\dmb2\Retire\Shared\Common\Customer Education\Lookout\2006...



 

Comings & Goings 
Process Support welcomes Erica Cooper; she 
is currently working on the backfile conversion 
effort. Erica is a mother of two boys and spent 
the last seven years working for Jackson 
National Life. She attended Douglas J 
Cosmetology School and enjoys participating 
in car shows all over the state where she 
shows off her customized ‘99 Alero low-rider. 

Welcome to Katie Lum who joined CSC on 
June 5. Katie previously worked for MDOT and 
DIT as a contract administrator. She enjoys spending time with her family and 
scrapbooking. She is married and has a 2-year-old son.  

Jen Morrisey and Trish Smith also joined the 
CSC. Both are reviewing applications. 

Jen previously worked for Tier Technologies 
scanning and processing information for child 
support checks. She is married and has two 
daughters, ages 15 and 17. She lives “in the 
middle of nowhere,” in Morrice, and spends 
her free time reading and doing work around 
the house. 

Trish previously worked at Vollman Ford in Portland as an administrative assistant. 

 

Erica Cooper 

 

Katie Lum

 

Jen Morrisey 

 

Trish Smith
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She has two daughters and four grandsons and plans on spending her summer 
remodeling her house. 

Kelsie Thelen, a student at the University of 
Michigan, recently joined the Director’s Office 
staff. She is majoring in Psychology and 
enjoys music. Kelsie plays the piano, French 
horn, and violin. 

Matt Torok started as a student assistant in 
the Director's Office on May 23rd. Matt is a 
senior at Michigan State working toward a 
interdisciplinary studies bachelor’s degree in 
social science. In addition, Matt coaches boy's 
basketball and soccer at IHM St. Casimir School. 

We offer a farewell and best wishes to Carol Keyes who joins Financial Services, 
Operations Division, on June 12. Carol was part of the training team; while she 
never made the move to the General Office Building, her coworkers will miss her 
contributions to the team. 

Say cheese! 
CED staff will be offering retakes for the photo board 
located in Crossroads. The retakes will keep this valuable 
tool up-to-date and looking great. 

It is the goal of CED to update all photos that are two or 
more years old. Appointments for a photo retake will be 
scheduled during the week of June 19. If you do not 
receive an appointment for a retake before June 19 and 
would like a retake, please contact Zach Wight at 636-
0797 or wightz@michigan.gov to set up a time. 

If you have any questions about the photo board update, 
please contact Erica Waltmire at 
waltmiree@michigan.gov or 322-5703. 

Recovering Word templates 
 

If you recently received a new computer, you may find that some of the templates 
you typically use aren’t appearing when you select File > New from the menu 
options. The templates didn’t disappear; Word just doesn’t know where to find them. 
So you need to tell Word where the ORS Workgroup Templates are located. 

In a nutshell, this is how it’s done: 

 Open Word, and at the top of the screen, click on the Tools dropdown menu 
and     select Options.  

 Click on the File Locations tab and click on Workgroup templates. Then click the 
Modify button at the bottom of the dialog box.  

 

Kelsie Thelen 

 

Matt Torok

ORS Mission: 
We deliver pensions, 
related benefits, and 
services to promote 
the future financial 

security of our 
customers. 

 
ORS Vision: 

Fast, easy access to 
complete and 

accurate information 
and exceptional 

service.

The LookOut is  
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published by the  
Office of Retirement 

Services, Department of 
Management and Budget, 

State of Michigan 
Director: Chris DeRose 

Edited by the 
Communications Staff, 

Customer Education  

Thanks for reading!! 

  

 In the Folder name box at the bottom of the window type: G:\Template, and then 
click the OK button. 

 Click OK again. 

 

 That’s it! Now, when you select File > New from the drop down menus, all of the 
ORS Workgroup Templates will be available. 

 Note: Because some of the links in this newsletter point to resources  
within ORS, some of the links may not work if you are outside of ORS. 
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